# Table of Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>eJournals - Introduction</strong></td>
<td>1-1</td>
</tr>
<tr>
<td>Oracle 11i eJournals</td>
<td>1-2</td>
</tr>
<tr>
<td>Oracle 11i - Abbreviations</td>
<td>1-3</td>
</tr>
<tr>
<td>Objectives</td>
<td>1-4</td>
</tr>
<tr>
<td>Agenda</td>
<td>1-6</td>
</tr>
<tr>
<td>ECU Business Processes - Naming Convention</td>
<td>1-7</td>
</tr>
<tr>
<td>ECU Business Processes - Approval Hierarchy</td>
<td>1-9</td>
</tr>
<tr>
<td>ECU Business Processes - Journal Categories</td>
<td>1-11</td>
</tr>
<tr>
<td>Journal Account Codes</td>
<td>1-13</td>
</tr>
<tr>
<td>Performing Journal Entry Functions</td>
<td>1-14</td>
</tr>
<tr>
<td>Journal Components</td>
<td>1-16</td>
</tr>
<tr>
<td><strong>eJournals - Entering Journals</strong></td>
<td>2-1</td>
</tr>
<tr>
<td>Agenda</td>
<td>2-2</td>
</tr>
<tr>
<td>Creating Journal Headers</td>
<td>2-3</td>
</tr>
<tr>
<td>Creating Journal Lines</td>
<td>2-5</td>
</tr>
<tr>
<td>Demonstration &amp; Practice</td>
<td>2-7</td>
</tr>
<tr>
<td>Practice - Create a GL Journal</td>
<td>2-8</td>
</tr>
<tr>
<td>Solution - Create a GL Journal</td>
<td>2-9</td>
</tr>
<tr>
<td><strong>eJournals - Reverse Journals</strong></td>
<td>3-1</td>
</tr>
<tr>
<td>Agenda</td>
<td>3-2</td>
</tr>
<tr>
<td>Creating Reversing Journals</td>
<td>3-3</td>
</tr>
<tr>
<td>Reversing Journals</td>
<td>3-4</td>
</tr>
<tr>
<td>Demonstration &amp; Practice</td>
<td>3-6</td>
</tr>
<tr>
<td>Practice - Reverse GL Journal Entries</td>
<td>3-7</td>
</tr>
<tr>
<td>Solution - Reverse GL Journal Entries</td>
<td>3-8</td>
</tr>
<tr>
<td><strong>eJournals - Posting Journals</strong></td>
<td>4-1</td>
</tr>
<tr>
<td>Agenda</td>
<td>4-2</td>
</tr>
<tr>
<td>Posting Journals</td>
<td>4-3</td>
</tr>
<tr>
<td>Demonstration &amp; Practice</td>
<td>4-5</td>
</tr>
<tr>
<td>Practice - Post GL Journals</td>
<td>4-6</td>
</tr>
<tr>
<td>Solution - Post GL Journals</td>
<td>4-7</td>
</tr>
<tr>
<td>Final points to remember for creating journals</td>
<td>4-9</td>
</tr>
<tr>
<td>Month End</td>
<td>4-10</td>
</tr>
<tr>
<td><strong>eJournals - Additional Functionality</strong></td>
<td>5-1</td>
</tr>
<tr>
<td>Additional Journal Functionality</td>
<td>5-2</td>
</tr>
<tr>
<td>Changing the Period for a Journal</td>
<td>5-5</td>
</tr>
<tr>
<td>Deleting a Journal</td>
<td>5-7</td>
</tr>
<tr>
<td>Attachments to Journals</td>
<td>5-9</td>
</tr>
<tr>
<td>Adding Attachments to a Journal</td>
<td>5-10</td>
</tr>
<tr>
<td><strong>eJournals - Journal Inquiries</strong></td>
<td>6-1</td>
</tr>
<tr>
<td>Journals (GL) Inquiry</td>
<td>6-2</td>
</tr>
<tr>
<td>Performing a Journal Inquiry</td>
<td>6-3</td>
</tr>
<tr>
<td>Drilling Down to Subledger Applications</td>
<td>6-5</td>
</tr>
<tr>
<td>T-Accounts</td>
<td>6-6</td>
</tr>
<tr>
<td>Display options available while viewing T-Accounts and Activity Summary</td>
<td>6-8</td>
</tr>
<tr>
<td>Demonstration &amp; Practice</td>
<td>6-10</td>
</tr>
<tr>
<td>Practice - Inquire on a General Ledger Journal</td>
<td>6-11</td>
</tr>
<tr>
<td>Solution - Inquire on a General Ledger Journal</td>
<td>6-12</td>
</tr>
<tr>
<td>Unposted Journals (GL) Inquiry</td>
<td>6-13</td>
</tr>
<tr>
<td>Performing an Unposted Journals (GL) Inquiry</td>
<td>6-14</td>
</tr>
<tr>
<td>Demonstration</td>
<td>6-16</td>
</tr>
<tr>
<td>Guided Demonstration - Inquire on Unposted Journals</td>
<td>6-17</td>
</tr>
<tr>
<td>Summary</td>
<td>6-18</td>
</tr>
<tr>
<td>Where to Now?</td>
<td>6-20</td>
</tr>
</tbody>
</table>

Copyright © Oracle, 2004. All rights reserved.

eJournals Training Course v2.1 Table of Contents
eJournals - Introduction

Chapter 1
Oracle 11i eJournals
Some common abbreviations used in this course:-

- (M) = Menu
- (B) = Button
- (Help) = Oracle Online Help Screens
- (N) = Navigator
- (I) = Icon
- (T) = Tab
- LOV = List of Values
- (H) = Hyperlink

**Common Abbreviations**

During this training session and future training sessions you will come across some standard menu path abbreviations that are used through the Oracle 11i documentation.
Objectives

After completing this lesson you should be able to:

- Understand ECU's business processes and identify the different journal entry functions and components
- Enter manual journals
- Reverse journals
- Locate and post your approved journals
- Additional journal functionality
- Inquire on GL Journals
Using Query Operators and Wildcard Characters

You can use any of the query operators listed in the table shown in the slide. You can also use the percent “%” wildcard character to represent any character or group of characters. For example, use “%SSF%” to search for all journals entered by Shared Services Finance. You can also use the underline “_” character to represent any single character. For example, “Product_” can represent ProductA, or Product1.
Agenda

- Understand ECU’s business processes and identify the different journal entry functions and components
- Enter manual journals
- Reverse journals
- Locate and post your approved journals
- Additional journal functionality
- Inquire on GL Journals
Filing of Documents:-

It is up to the individual areas to file their journals, along with any required attachments. Oracle 11i does have the functionality of attaching documentation to on-line journals which we will cover later in the course.

If your journal was written on hard copy, this hard copy must be filed. If you enter the journal straight into the General Ledger, a hard copy of the entered journal does not need to be kept.

GPS recommend that the register is kept for each year and any filing is filed per year and per number order to match the register.

Audit Processes

Audit reports on the journals names will be produced and any areas that do not comply could lose the benefits of entering their own journals.

Month End

The first day of each month is the last day that you can enter journals for them to be included in the month end. The cut-off time is 4pm. Please refer to the Shared Services Finance webpage for further details on the month end calendar


All journals with a status of Unposted for a previous period will be deleted seven (7) days after the new month has opened.
ECU has adopted strict naming conventions for journals to ensure unique numbering and to assist users in locating journals. It is up to the individual areas, however, to ensure a register of the number is kept. The naming convention that has been approved is:

Faculty/Centre / School/Branch / Initials of enterer / Register number

Eg. FBSC/SYS/TP/001

The number register may be kept at individual or business unit level. It is important that the naming convention is adhered to as Oracle 11i will allow a number to be used multiple times. Please check with your business manager/supervisor whether there is a central register.
Every staff member that has access to GL journals has a supervisor and a GL journal approval limit listed against their account.

When you raise a journal that is above your limit, it will go to your supervisor for approval. If it above their limit, it will then go to their supervisor etc until it reaches someone who can approve against the amount.

You cannot nominate who will receive an individual journal for approval, the journal will only follow your set approval path.

Approval Hierarchy:-
In the new General Ledger Journal Entry functionality, an approval hierarchy has been put in place. For the approval hierarchy to be effective, the debiting cost centre must raise the journal, as the journal will follow the approval path of the person entering the journal. Hierarchies will be reviewed periodically by Faculty Accountants and Business Managers.
ECU Business Processes – Journal Categories

There are several categories you can use depending on the type of journal you are raising:

- **Miscellaneous**
- **Adjustment**
- **Internal Charge**
- **Accrual**

**Journal Categories:**

**Miscellaneous Journals – Category Name = Miscellaneous**

Miscellaneous journals are to be used for the general day-to-day allocation/distribution of revenue and expenditure and should be used for any item of revenue or expenditure that has not been invoiced. Examples of such journals include the distribution of student fees from a faculty to its various cost centres or projects or the allocation of expenditure amongst various cost centres/projects.

**Adjustment Journals – Category Name = Adjustment**

Adjustment journals are used where a journal is being created to correct a portion of a previous transaction. The original transaction should have occurred as follows:

- An expenditure should have been incurred and entered (and paid) and not merely an encumbrance; or
- An income should have been received and receipted.

If an entire journal is being corrected then the original journal should be reversed and a new miscellaneous journal must be created, making reference to the original journal within the description field.
If a journal adjustment is required, the preferred method is to make the correction in the source system i.e. on the invoice. By using this method, the changes will flow through to the GL during the nightly process.

**Internal Charge Journals – Category Name = Internal Charge**

To be used for internal transactions only i.e. transactions for the provision of services/goods between one cost centre/project and another cost centre/project. All internal charge journals must have the internal transaction expense account and the corresponding internal transaction account revenue to ensure they net each other off.

Example: Assume the Print and Design Cost Centre charges the Marketing Cost Centre for printing services that the Marketing Cost Centre uses. The journal entry would be as follows:-

<table>
<thead>
<tr>
<th>Debit</th>
<th>Account 9617 (Internal Print and Design Expense)</th>
<th>100.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credit</td>
<td>Account 1917 (Internal Print and Design Income)</td>
<td>100.00</td>
</tr>
</tbody>
</table>

**Accrual Journals – Category Name = Accrual**

Accrual Journals may be entered at the end of a month (particularly in December for the end of the financial year) for revenue or expenditure which may have been incurred but which has not yet been processed. Accruals will be automatically reversed in the following month, unless selected to be reversed in an alternative future month. As accrual journals affect the balance sheet, they may only be processed by Shared Services Finance with the approval of the Financial Accounting Manager.
Journal Account Codes

When entering a journal you are not permitted to use any balance sheet or salary account codes i.e. accounts beginning with 0 or 2.

However, you may use the internal transfer of funds accounts which begin with 00, or the salary recoup code below:

- 0050 – Transfer of Funds Inflow Intra (must be used with 0060)
- 0060 – Transfer of Funds Outflow Intra (must be used with 0050)
- 0051 – Transfer of Funds Inflow Intra (must be used with 0061)
- 0061 – Transfer of Funds Outflow Intra (must be used with 0051)
- 2650 – Salary recovery
Performing Journal Entry Functions

Using Oracle General Ledger, Oracle subledgers, and Oracle ADI, you can perform the following journal entry functions:-

- Create journal entries in Oracle General Ledger
- Post journal entries
- Inquire on account information and journal entries
- Drill down to subledgers
- Run reports
- Reverse journal entries
- Use ADI to enter large journals from a spreadsheet. A standard ADI template is available from SSF to enable them to process your journal faster. A copy of this template can be downloaded from the SSF webpage at the following link http://www.fbse.ecu.edu.au/ss/resource/SSF_GL_JournalULONG Upload.xls Once you have completed the spreadsheet you can forward it to SSF who will import it to the General Ledger. Please ensure that you do not use formulas in your ADI template as this causes errors during the upload process which will delay the processing of your journals. The current process of approvals is required in relation to spreadsheets i.e. you can email the spreadsheet to SSF but must then send through the signed copy of the journal. It is recommended that any recurring journals that are longer than 10 lines are input via ADI journal format by Shared Services Finance.
Within Oracle General Ledger, you can work with the following types of journal entries:-

- Manual Journal Entries: The basic journal entry type is used for most accounting transactions. Examples include adjustments and reclassifications.
- Reversing Journal Entries: Reversing journal entries are created by reversing an existing journal entry. You can reverse any miscellaneous, adjustment or internal journal entry and post it to the current or any future open accounting period.
Every journal entry in Oracle General Ledger has two components.

Journal Components

Every journal entry belongs to a batch. Oracle General Ledger automatically creates one batch for each journal entry, defaulting the name (as per the naming convention) and the latest open period.

Note: ECU has a naming convention which must be adhered to for all journals. All entered journals will be checked for audit purposes and any deviation from the policy may result in the eJournal responsibility being revoked from those offenders.

**Journal Header Information:**
- The header information identifies common details for a single journal entry, such as name, effective date, category, currency and description.

**Group related lines into journal entries:**
- All lines in a journal entry must share the same currency and category.

**Journal Line Information:**
- Journal lines specify the accounting information for the journal entry.
- Total debits must equal total credits for a journal entry for all journal entries.
• Description for each line can be entered optionally. Initial value will default from the description on the journal header. To assist with more detailed reporting and inquiries, it is recommended that line descriptions be added.
Agenda

- Understand ECU's business processes and identify the different journal entry functions and components
- **Enter manual journals**
  - Reverse journals
  - Locate and post your approved journals
  - Additional journal functionality
  - Inquire on GL Journals
Creating Journal Headers

Use this window to enter journals. Once you have entered journal lines, you can examine your journal entries in detail and in T-Account or Summary Activity view. Before posting, you can review and update any journal entries you entered manually.

How to Create a Journal Header:-
1. (N) ECU GL Journals User > Enter GL Journal > (B) New Journal.
2. In the Journals window, enter a Journal name using the ECU naming convention previously discussed.
3. Enter the Period for the journal entry. Note: that you can only post journals in Open periods. If you attempt to use a closed period, the system will not let you continue until you select an open or future period.
4. Accept or change the default Effective Date for the journal entry.
5. Enter a Category as described in the ECU Business Processes section i.e. Miscellaneous, Adjustment or Internal Charge. All lines in a journal entry share the same journal category.
6. Enter an optional Description for the journal entry. General Ledger uses this as the default description for each journal entry line. You can change the journal entry description as necessary.
7. (Optional) Enter Reference description to further identify the journal entry on general ledger and journal entry reports.
8. Your functional currency appears as the default currency (AUD is the functional currency). To enter a foreign currency journal, specify the currency you want to use and select the corporate exchange rate. The exchange rates have been entered by the Tax/Treasury department. If you require a currency that is not available, contact the Tax/Treasury department for further assistance.

9. (Optional) In the Reverse region, enter a reverse Period. The journal will be automatically reversed when this period is opened. Reversal methods are being covered in more details later in the next chapter.

10. You are now able to enter Journal Lines.
Creating Journal Lines

How to Create Journal Lines:-
2. Enter a Line Number for each journal line to control the sequence in which the journal entry lines appear online and in reports. After you enter the first journal entry line number, General Ledger automatically increments the numbers for the following lines. You can change the line numbers as necessary.
3. Enter an account for the journal line. If you know the flexfield this can be typed in using a fullstop ‘.’ Between each segment, alternatively you can click on the List of Values (LOV) at the end of the field and you are then able to search for codes/descriptions of your segments.
4. Enter the Debit or Credit amount for the designated account.
5. Tab through the fields on the journal and enter any additional information that is required.
6. Once you have entered all the lines in your journal, (I) Save or Ctrl-S.
7. (B) Approve. If the journal amount is under your limit, the journal will be automatically approved. If the journal amount is over your approval limit, it will be forwarded to your supervisor for approval. You will be advised via email when the approval has been actioned.
8. **(B) Post.** Once approved you are able to immediately post the journal to the General Ledger. The information will be available in reports/on-line inquiries. If you do not post the journal, it will be picked up in the next Autopost process which is regularly run. If you want to make changes to your journal, save it, but do not approve it, otherwise it will be posted overnight.

**Other Buttons**

**(B) Post**

Once your journal has been approved you are able to Post it. Once posted, the information will be available for reporting.

**(B) Reverse**

Once your journal has been approved and posted, you are able to reverse it. This button will be explained later in this chapter.

**(B) Approve**

This button will approve your journal and make it available for posting. If the journal amount is over your approval, it will be forwarded to your Supervisor for approval. The Approval Status will change to “In Processing”. When your Supervisor approves the journal, the Approval Status will change to “Approved” and the journal can then be posted. Prior to posting you are also able to (B) Unapprove the journal to make amendments and then re-approve the journal.

You will receive Journal Approval notifications via email and they will also be displayed on your Worklist at the top of your Oracle eBusiness Home Page.

**(B) Line Drilldown**

This button is only enabled on journals that have been imported from a Subsidiary system i.e. Payables, Receivables and Assets.

**(B) T Accounts**

Use the T Accounts window to view General Ledger journals or subledger accounting entries in a graphical T Account format. This is covered later in the course under Inquiries.
Demonstration & Practice

- Create General Ledger Journals

Guided Demonstration & Practice
Practice - Create a GL Journal

Overview

In this practice, you will create several journals, approve and post the journals you have created.

Assumptions

- You must have access to the Training database to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System

- Username = trainXX
- Password = trainXX
- Responsibility = ECU GL Journals User

1. (N) Enter GL Journal.

2. Create the first Journal
   - Journal = Use the naming convention previously described i.e. FBSC/SYS/TP/001, but use the convention you would use in your role.
   - Period = Current period
   - Category = Miscellaneous
   - Description = Recoup for Advertisements

<table>
<thead>
<tr>
<th>Line</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>68000.2430.4251.SA.06.01</td>
<td>500</td>
<td></td>
<td>Recoup for Advertisements</td>
</tr>
<tr>
<td>20</td>
<td>69600.2515.4251.SA.04.01</td>
<td></td>
<td>500</td>
<td>Recoup for Advertisements</td>
</tr>
</tbody>
</table>

3. Save, approve and post your journal. Note down journal name: ________________________

4. Create a second journal
   - Journal = Using the naming conventions previously described, remember to increase your journal number by one.
   - Period = Current period
   - Category = Miscellaneous
   - Description = Consultants Fees

<table>
<thead>
<tr>
<th>Line</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>68200.2490.2801.SA.06.01</td>
<td>1250</td>
<td></td>
<td>Consultants Fees</td>
</tr>
<tr>
<td>20</td>
<td>68100.2430.2801.SA.06.01</td>
<td></td>
<td>1250</td>
<td>Consultants Fees</td>
</tr>
</tbody>
</table>

5. Save and approve your journals.
   - Ensure that you do not post this journal. Note down journal name:
   ________________________
Solution – Create a GL Journal

Responsibility: ECU GL Journals User

Create First Journal

1. (N) Enter GL Journal > (B) New Journal

2. Create First Journal
   − Journal = As per naming convention
   − Period = Current period
   − Category = Miscellaneous

3. Enter the following:

<table>
<thead>
<tr>
<th>Line</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>68000.2430.4251.SA.06.01</td>
<td>500</td>
<td></td>
<td>Recoup for Advertisements</td>
</tr>
<tr>
<td>20</td>
<td>69600.2515.4251.SA.04.01</td>
<td></td>
<td>500</td>
<td>Recoup for Advertisements</td>
</tr>
</tbody>
</table>

4. (I) Save or Ctrl-S.

   Note down journal name: ____________________________________

5. (B) Approve.

6. (B) OK.

7. (B) Post.

8. (B) OK.

Create Second Journal

9. Place cursor in journal header.

10. (M) File > New or use the Down Arrow
    − Journal = as per naming convention
    − Period = Current period
    − Category = Miscellaneous

<table>
<thead>
<tr>
<th>Line</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>68200.2490.2801.SA.06.01</td>
<td>1250</td>
<td></td>
<td>Consultants Fees</td>
</tr>
<tr>
<td>20</td>
<td>68100.2430.2801.SA.06.01</td>
<td>1250</td>
<td></td>
<td>Consultants Fees</td>
</tr>
</tbody>
</table>

11. (I) Save or Ctrl-S. You will notice an error window relating to Hours Worked. Certain account codes (2801 is one of them) are linked to an additional window which will request entry of hours worked before allowing you to save your work. To access this window (B) OK for the error window, then tab across the journal line until the Hours Worked window
opens. Enter the value 35 (B) Ok. Repeat this process for the second line, then save your work.

Note down journal name: ________________________________

12. (B) Approve.

13. (B) OK.


15. (I) Find and enter the name of your journal that you have just entered.

16. (B) Find.

17. (B) Review Journal

18. Check the Batch Status = Approved.

19. (M) File > Close Form.
eJournals - Reverse Journals

Chapter 3
Agenda

- Understand ECU’s business processes and identify the different journal entry functions and components
- Enter manual journals
- Reverse journals
- Locate and post your approved journals
- Additional journal functionality
- Inquire on GL Journals
Creating Reversing Journals

You create reversing journals for various reasons i.e. miscoding of the original journal, adjustments or monthly accruals.

- A journal entry can be reversed only once. However, you can reverse a reversing journal entry.
- You can reverse a journal entry in any period after the journal entry is posted. You cannot reverse a journal in a prior period.
- If you reverse a journal, General Ledger creates a reversing journal entry. General Ledger automatically names the reversal journal Reverses [Original Journal Entry Name] [Date] [Time]. The reversal journal must also be approved and posted.
- You can only reverse a posted journal. If you need to reverse a journal that has been approved but not posted, you must (B) Unapprove the journal and then delete it, you don’t need to reverse it.
Reversing Journals

Creating Reversing Journals

You create reversing journals for various reasons i.e. miscoding of the original journal, adjustments or monthly accruals.

You have three options for selecting journal entries for reversal:-

1. You can select a journal category eg. accruals which will automatically reverse when the next period is open.
2. You can create the reversal immediately in the Enter journals window after the original journal has been entered.
3. When you create a Journal, you can enter the period you wish the reversal to occur and when that period is opened the journal will reverse automatically.

Note: If you select the Reversal button in the Enter Journal (ECU) or the Journals (ECU) Windows, the reversing journal will be created immediately.

To Reverse a journal:-

1. ECU GL Journals User > Enter GL Journal.
2. Query the Journal that you want to reverse.
3. (B) Find.

5. (B) Reverse to generate an unposted journal. General Ledger names the reversal journal
   \textit{Reverses [Original Journal Entry Name] [Date] [Time]}.

6. You will be asked for a period to reverse the journal. Select the appropriate period.
   Remember that you cannot post a journal that has been reversed in a future period.

7. Choose OK.

8. Locate the reversal journal in the Enter Journals (ECU) Window. Use the \% wildcards at
   the start and end of journal name and this will find both the original journal and the reversal
   entry.

9. (B) Approve.

10. (B) OK.

11. (B) Post the reversing journal.

\textbf{Note:} If you query the original journal, the status will now show ‘Reversed’.
Demonstration & Practice

- Create reversing Journal entries

Guided Demonstration & Practice
Practice - Reverse GL Journal Entries

Overview

In this practice you will learn how to:

- Reverse the Journal

Assumptions

- You must have access to the Training database to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System
- Username = trainXX
- Password = trainXX
- Responsibility = ECU GL Journals User

Find a Journal

1. (N) Enter GL Journal
2. Locate the first Journal you created and posted earlier.
3. Review the Journal.

Reverse a Journal.

4. Reverse the journal entry in the latest open period.

Approve and Post the Journal.

5. Find the reversal journal that has been created.
7. Post the reversal Journal to negate the effect of the original Journal.
Solution - Reverse GL Journal Entries

Responsibility = ECU GL Journals User

Find a Journal
1. Open the Find Journals window.  
   (N) Enter GL Journal

2. In the Journal Name of the Find Window, enter the name, or part of the name, of the journal you entered previously.  
   − Hint: If you can’t remember the whole name, remember you can use the wildcard % at the start and end of your journal name to refine your search eg. %FBS%SSF%AB%

3. (B) Find.

4. (B) Review Journal.

Reverse a Journal
5. From the Journals window, select (B) Reverse to reverse the journal entry.

6. Select the same period the journal was created in to reverse the journal, and select the OK button to the message that appears.

Posting a Journal
   − Hint: a new journal has been created with a journal name: Reverse "[the name of your journal]"<Date><Time>. Use the % wildcard at start and end of journal name.

8. (B) Approve.

9. (B) OK.

10. Post the reversal Journal to negate the effect of the original Journal.

11. (B) Post.

12. (B) OK.
eJournals - Posting Journals

Chapter 4
Agenda

FINANCE AND BUSINESS SERVICES CENTRE

- Understand ECU’s business processes and identify the different journal entry functions and components
- Enter manual journals
- Reverse journals
- Locate and post your approved journals
- Additional journal functionality
- Inquire on GL Journals
Posting Journals

When you enter your own journals you are able to post them as soon as they have been approved, and the information will be in your reports (excluding Cognos, which is refreshed overnight) as soon as the posting process has completed.

If you are sending ADI journals to Shared Services Finance (SSF) for uploading and use the approved template format, the journals will be posted immediately once uploaded. If, however, you do not use the SSF ADI template, the journal will be returned to you, so that the correct format is used, which will cause delays. The template can be found in FBSC Online Forms at http://www.fbsc.ecu.edu.au/ss/resource/SSF_GL_Journal.Upload.xls

In addition to manually posting a journal, there is a process running behind the scenes to post journals on a regular basis. Note: When you post a journal, its contents, including descriptive flexfields, cannot be modified. Reversal information within a posted unreversed journal can be modified.

If you send a Journal to SSF there is an approximately five (5) day turnaround for them to be entered and posted. During month end this is dependent on the month end timetable. A copy of the timetable can be located on the FBSC Reporting webpage at http://www.fbsc.ecu.edu.au/rpt/html/monthendyearend.cfm
Posting a journal:-
1. (N) ECU GL Journals User > Enter GL Journal
2. Query the journal you want to post. You can also query all unposted journals.
3. (B) Find.
4. (B) Review Journal to review the details of your Journal. The Journal widow appears.
5. Review the Period Status and Post Status to determine if the Journal is available for posting i.e. open period, journal is unposted and has been approved.
6. (B) Post to submit a concurrent request to post the selected journal.

Note: Journals must have a status of Posted to show on your reports.

Posting errors:-
You may receive an error once you have posted your journal which will show in the batch status if you query the journal. This could be caused by a flexfield value becoming invalid i.e. closed. If this is the case you will need to review your journal, unapprove the journal, make the change and re-approve which will re-start the approval process. If you are having problems, please contact Andrew Dallimore in Financial Accounting.
Demonstration & Practice

- Posting Journals

Guided Demonstration & Practice
Practice - Post GL Journals

Overview

There are several methods to Post Journals. You can use the Journal Enter window, Review Journal window or Autopost. In this practice, you will use the Review Journal window to post journals.

Assumptions

- You must have access to the Training database to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System
- Username = trainXX
- Password = trainXX
- Responsibility = ECU GL Journals User

Post a journal using the Review Journal Window

1. (N) Enter GL Journals
2. Find the second journal you created in your exercises earlier.
3. Review the journal.
4. Post the journal.
5. Check the output or use (B) Requery to ensure the journal posted without any errors.
Solution - Post GL Journals

Post Journals using the Journal Entry Window

1. (N) Enter GL Journals

2. Enter the name of the second journal you created in your first exercise.
   - Hint: you can select Unposted in the Posting Status to reduce the number of records returned. You can also use the % wildcard operators.

3. (B) Find.

4. (B) Review Journal.

5. (B) Post

6. To check the output (M) View > Requests

7. (B) Find

8. (B) Refresh Data

9. (B) View Output to ensure that no errors occurred

10. Alternatively, you can re-query your journal and check the batch status. If posted successfully the status should be ‘Posted’.

11. (M) File > Close Form, until you return to the Navigator
Final points to remember for creating journals

There are three steps to a journal:
1. Create the journal
2. Approve the journal
3. Post the journal

Or

1. Reverse a journal
2. Approve the reversal journal
3. Post the reversal journal
Month End

FINANCE AND BUSINESS SERVICES CENTRE

- The 1st working day of a month is the last day to enter journals for the previous month.
- Ensure all journals have been approved, if they haven't been approved they will not get posted.
- All journals that have been approved but not posted will be posted overnight by the system.
- Any journals for a prior period that have not been approved will be deleted seven days after the new month opens, unless you change the period, approve and post it into the new month.
eJournals - Additional Functionality

Chapter 5
Additional Journal Functionality

In addition to the standard create journals and reverse journals, there are some additional functions that may assist you in interrogating your data more effectively.

Journal Status:-
If your journal has been rejected by your approver, you must requery the journal, make the required changes and re-submit the journal for approver. This will send another notification to your approver to re-approve the journal.

Unapprove a Journal:-
If your journal has been approved and it has not been posted, you are able to select (B) Unapprove to make changes and re-submit the journal for approval. This can only be done by the originator of the journal.

Running Reports:-
You are able to run a variety of reports to assist in your analysis of transactions. These reports include:-
- Account Analysis – (180 Char)
- Account Analysis – Payables Detail(180 Char)
- Account Analysis – Subledger Detail (180 Char)
- General Ledger – (180 Char)
- Journals – General (180 Char)
- Trial Balance – Summary 1

For more information on reporting, please enrol in the Reporting Training Course. Please see the list of courses on offer from Professional Development at https://orian.ecu.edu.au/
Changing the Period for a Journal
Changing the Period for a Journal

If a journal was not approved and posted in the month it was entered, you can change the period to the following month and approve and post the journal.

After the end of the month, you will have seven (7) days to change the period on an existing journal and post it in the new month. Any journals not approved and posted after this time will be deleted from the system.

To change the period on a journal, the status must either be unapproved, or rejected. If the journal has been approved, you must unapprove it to be able to change the period. To unapprove an approved journal, open the journal and click (B) Unapprove and save the journal.

To change the period on a journal:-
1. Find and open your journal
2. (M) Tools > Change Period
3. Choose the new period using the LOV (list of values)
4. (B) Ok
5. You must now have the journal approved and posted as per normal.
Deleting a Journal
Deleting a Journal

If a journal has not been posted, you can delete it from the system if it is no longer required.

To delete a journal it must not be posted, the status must either be unapproved, or rejected. If the journal has been approved, you must unapprove it to be able to delete it. To unapprove an approved journal, open the journal and click (B) Unapprove and save the journal.

To delete a journal:

1. Find and open your journal
2. Place your cursor in the Header section of the journal
3. (I) Delete
4. (B) Yes
5. You can now save your changes and the journal will be deleted.
6. If you want to check, requery the journal – it should not return any records.
Attachments to Journals
Adding Attachments to a Journal

With new functionality in Oracle 11i you can now attach supporting documentation to your GL journal. The attachments are saved to the Oracle database and can be viewed whenever the journal is queried.

Note: If you are adding attachments we recommend to add them when you’re creating the journal. Attachments can be added after the journal is approved, but attachments cannot be added once the journal has been posted.

How to add Attachments to a Journal:-
1. Enter the header information for your journal. Leave your cursor in the header as you can only attach at the header level.
2. Click on the paperclip icon on the toolbar, as shown by point 2 on the screenshot above.
3. You will receive a confirmation asking you to commit your work (B) Yes to commit.
Adding Attachments to a Journal

Adding an Attachment to a Journal continued:

After committing (saving) your journal:-

4. The attachments window will open.

5. (T) Main

6. Category = Journal

7. Description = enter relevant description

8. Data Type = use the LOV to choose the type of attachment.
   - If you select ‘File’ a browser window will open for you to select the file to attach. Once you’ve selected your file (B) Ok. A notification window will appear to let you know if upload was successful. If so, close browser window to return to Oracle. Click (B) Yes on Oracle Decision window. If the file upload wasn’t successful, repeat step 9 until it is.
   - If you select Long or Short Text, the text window below will become available to allow you to enter your text.
   - If you select web page, you will need to enter the URL.

9. Close attachments window. The Paperclip icon on the toolbar should now show paper in the icon (it looks a bit like a padlock).

10. Continue to enter your journal lines, save, approval and post as per normal.

Note: Whenever a journal with an attachment is queried or viewed, the attachment can also be viewed by clicking on the paperclip icon.
Journals (GL) Inquiry
Performing a Journal Inquiry

Use the Find Journals window to find journal batches and journal entries. General Ledger displays search results in the Enter Journals window. You can also use the Query by Example or shortcut (B) F11 to run queries within the Enter Journals window.

This allows you to review detailed information about a batch, a journal entry within that batch, and the detail lines within that entry, drill down from a journal to see the subledger transactions that comprise it and view journal and subledger transaction information as balanced accounting entries or in the form of T-Accounts.

To perform a Journal Entry Inquiry:-

1. (N) Inquiries > Journal (GL)

   **Note:** When you first navigate to the Journal Inquiry window from the Oracle E-Business Home Page, the Find Journals window appears automatically.

2. In the Find Journals window, enter query parameters to find the journal batch you want to review.

3. Once you have entered all of your query parameters, (B) Find to run the query. The journal batches or journals that meet your query criteria appear in the Journal Entry window.
To perform a Journal Entry Inquiry from the Enter Journals window:-
1. (M) View > Query by Example > Enter or shortcut (B) F11
2. The Enter Journals window will appear with green fields for query entry.
3. Enter the search criteria. You can use the % wildcard to assist your search.
4. To execute the query (M) Query by Example > Run or shortcut (B) Ctrl+F11
When you perform an account or journal inquiry in General ledger, you can drill down to view transaction-level detail if the transactions originated in an Oracle subledger application i.e. Payables, Receivables, Assets (except depreciation) and Purchasing.

**To review journal detail generated from a Subledger application:**

1. Perform an account or journal inquiry. For an account inquiry, drill down to the journal detail.
2. Review the journal and select a journal detail line where the journal source is a subledger i.e. Payables or Receivables.
3. Choose (M) Tools > Line Drilldown from the menu or alternative (B) Line Drilldown if you are in the Journal Lines. The related subledger’s accounting window appears. From there you can drill down further to view the subledger transaction. You can also view the transaction accounting, as balanced accounting entries or in the form of T-Accounts.
Use the T-Accounts window to view General Ledger journals or subledger accounting entries in a graphical T-Account format, displayed in the T-Accounts window. The system displays information such as the account, the activity detail, the net activity for the entry, and the account balance.

You can also choose to view journals or subledger accounting entries as an activity summary report, displayed in the Activity Summary window. The window displays information such as the account, the net activity for the entry and the account balance.

T-accounts can be accessed from:-

**General Ledger:** from the Enter Journals, Journals, and Journal Entry Inquiry windows. T-Accounts can also be accessed via an account inquiry, by first drilling down to the Journals window.

**Oracle Subledger Applications:** from the related subledger's view accounting or accounting windows.

**To view T-accounts:**

1. Choose (M) Tools > T-Accounts from the menu. Alternatively, from some windows you can choose the T-Accounts button.
2. (Conditional) The first time you access T-Accounts, the T-Accounts window appears. You can then specify what window should open the next time you choose to view T-Accounts.
3. To choose how you want the information displayed, click (B) Options. For example, you can choose to view by full accounting flexfield or by segment. You can also choose whether account balances should be displayed.
4. Choose the T-Accounts or Activity Summary button to open the related window.
Display options available while viewing T-Accounts and Activity Summary

T-Accounts

The following display options are available from the Options window:-

**Default Window:** choose which of the three windows appears when you choose to view T-Accounts:-

- **Options:** the Options window
- **T-Accounts:** the T-Accounts window will be displayed
- **Activity Summary:** the Activity Summary window will be displayed

**Organise By:** determines how your accounts are organised in both the T-Accounts and Activity Summary windows:

- **Account:** Each account is displayed as a separate T-Account. The Activity Summary lists accounting activity by account.
- **Segments:** Specify a primary and secondary segment. Each unique combination of the two segments is displayed as a separate account.

**Show in T Accounts:**

- **Account Description:** Yes or No. Yes is the default.
- **Balances:** Yes or No. No is the default. This choice is only for General Ledger journal entries.
• **Entered Amounts**: Yes or No. Yes is the default.
• **Activity**: Yes or No. Yes is the default.

**Show in Activity Summary**:—
• **Account Description**: Yes or No. The default is Yes.
• **Balances**: Yes or No. No is the default. This choice is only for General Ledger journal entries.
• **Entered Amounts**: Yes or No. Yes is the default.
• **Columnar display poplist**: Choose Debit and Credit Column to display debits and credits in separate columns. Choose Net Amount Column to display the net amount of debits and credits in one column.

**Note**: You cannot view activity detail in the Activity Summary window.
**Note**: You can only display functional currency amounts in the Activity Summary window.
**Note**: Your display option selections are automatically saved and will be used the next time you view T-Accounts.
**Note**: The Options, T Accounts, and Activity Summary windows are all linked. From any of these windows you can get to the other two by choosing the appropriate button.
Demonstration & Practice

FINANCE AND BUSINESS SERVICES CENTRE

- Journal Inquiry
Practice - Inquire on a General Ledger Journal

Overview

In this practice, you will do the following:

- Inquire on a Journal.

Assumptions

- You must have access to the Training database to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System

- Username = trainXX
- Password = trainXX
- Responsibility = ECU GL Journals User

Do a journal inquiry for all journals entered in Oct-06 by Shared Services Finance.

1. Which journal has a Source of Manual?
2. What is the status for journal FBS/SSF/AF/0534?
3. What is the description in the Journal Header for journal FBS/SSF/AF/0539?

Do another journal inquiry for all journals entered in Oct-06 with a source of Payables and category of Purchase Invoices

Review a journal

Drill down to T-Accounts
Solution - Inquire on a General Ledger Journal

1. (N) Inquiries > Journal (GL)

2. In the Journal Entry search field, you need to enter parameters:
   - Journal Name = %FBS%SSF%
   - Period = Oct-06

3. (B) Find

4. Which journal has a source of Manual?     FBS/SSF/MS/0544
   Note: Look in the Source column.

5. What is the status for journal FBS/SSF/AF/0534?     Posted
   Note: Look at the Batch Status column, or (B) Review Journal > Status Box in the journal header.

   Note: (B) Review Journal > Description field.

7. Close all screen to return to Navigator for second query.

8. (N) Inquiries > Journal (GL)

9. In the Journal Entry search field, you need to enter parameters:
   - Source = Payables
   - Category = Purchase Invoices
   - Period = Oct-06

10. (B) Find

11. (B) Review Journal

12. (B) T Accounts

13. Close all windows to return to Navigator.
Unposted Journals (GL) Inquiry
Performing an Unposted Journals (GL) Inquiry

Use the Find Journals window to find journals that haven’t been posted yet. General Ledger displays search results in the Post Journals screen.

This allows you to review information about journals that are not yet posted to establish why they are not posted. In most cases that’s usually because the journal is not approved yet, or the period is no longer open.

Note: this is an inquiry screen – you cannot post or change any of the information here.

To perform an Unposted Journal (GL) Inquiry:-

1. (N) Inquiries > Unposted Journals (GL)
   
   Note: When you first navigate to the Unposted Journals (GL) Inquiry window from the Oracle E-Business Home Page, the Find Journals window appears automatically.

2. (Optional) In the Find Journals window, enter query parameters to find the journal of which you want to check the status.
   
   Note: if you don’t specify any search criteria then the system will return a list of ALL unposted journals (in theory there shouldn’t be that many of them).
3. Once you have entered all of your query parameters, click (B) Find to run the query. The journal batches or journals that meet your query criteria appear in the Journal Entry Inquiry window.

**Note:** Where the text is grey and the field background is white (see screenshot) the Journal is Not Postable and the reason why is shown in the Batch Information section. Where the text is black and the field background is grey the Journal is Postable (but not in this inquiry screen).

If you find one of your journals is Unposted, you will need to take action to resolve it. You can either:

- Go to the Journal Entry screen, find your journal and post it (if it is postable)
- Go to the Journal Entry screen, find your journal and change the period (if it is not postable because the Period Status is ‘Closed’),
- Ask your approver to reject the journal approval request so that you can delete it (if the journal is unapproved, and you no longer want it).
- Ask your approver to approve the journal approval request so that you can unapprove it, change the period and resubmit it for approval (if the journal is unapproved and the period is closed, but you still need the journal to go through in the current month).
- Ask the approver to approve the journal approval request so that you can post it (the journal is unapproved and the period is still open).

**Note:** You can also run a query from the Enter Journals window with a search criteria of Unposted in the Status window.
• Unposted Journal (GL) Inquiry
Guided Demonstration - Inquire on Unposted Journals

In this demonstration you will see how to inquire on a Journal.

1. (N) ECU Generic Reporting and Inquiries > Inquiries > Unposted Journals (GL).

2. On the Find Journals Batches screen, you can enter search criteria:-
   – Period = Sep-06 (for example)

3. (B) Find
Summary

After completing this course you should now be able to:

- Understand ECU’s business processes and identify the different journal entry functions and components
- Enter manual journals
- Reverse journals
- Locate and post your approved journals
- Additional journal functionality
- Inquire on GL Journals
Where to Now?

FINANCE AND BUSINESS SERVICES CENTRE

Oracle Just in Time (JIT)

- Reporting Just in Time (JIT)
- Procurement - External Catalogues & Receiving
- Procurement - Non-Catalogues & Receiving
- AP / PO Inquiries
- GL Journals
- AR Invoices
- Assets

Basic Financial Reporting

Advanced Financial Reporting